Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.

- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.

- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

- Microchip is willing to work with the customer who is concerned about the integrity of their code.

- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights.

Trademarks

The Microchip name and logo, the Microchip logo, Accuron, dsPIC, KeeLog, KeeLog logo, MPLAB, PIC, PICmicro, PICSTART, PRO MATE, rPIC and SmartShunt are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

FilterLab, Linear Active Thermistor, MXDEV, MXLAB, SEEVAL, SmartSensor and The Embedded Control Solutions Company are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Analog-for-the-Digital Age, Application Maestro, CodeGuard, dsPICDEM, dsPICDEM.net, dsPICworks, dsSPEAK, ECAN, ECONOMONITOR, FanSense, In-Circuit Serial Programming, ICSP, ICEPIC, Mindi, MiWi, MPASM, MPLAB Certified logo, MPLIB, MPLINK, mTouch, PICkit, PICDEM, PICDEM.net, PICtail, PIC32 logo, PowerCal, PowerInfo, PowerMate, PowerTool, REAL ICE, rPICLAB, Select Mode, Total Endurance, UNI/O, WiperLock and ZENA are trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

All other trademarks mentioned herein are property of their respective companies.

© 2008, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.

Printed on recycled paper.

Microchip received ISO/TS-16949:2002 certification for its worldwide headquarters, design and wafer fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC® DSCs, KeeLog® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and analog products. In addition, Microchip’s quality system for the design and manufacture of development systems is ISO 9001:2000 certified.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preface</strong></td>
<td>1</td>
</tr>
<tr>
<td><strong>Chapter 1. Using the USB Device Firmware Framework</strong></td>
<td></td>
</tr>
<tr>
<td>1.1 Highlights</td>
<td>5</td>
</tr>
<tr>
<td>1.2 Overview of the Framework</td>
<td>5</td>
</tr>
<tr>
<td>1.3 USB Device Firmware in the Framework</td>
<td>8</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>13</td>
</tr>
<tr>
<td><strong>Worldwide Sales and Service</strong></td>
<td>14</td>
</tr>
</tbody>
</table>
Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and documentation are constantly evolving to meet customer needs, so some actual dialogs and/or tool descriptions may differ from those in this document. Please refer to our web site (www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each page, in front of the page number. The numbering convention for the DS number is “DSXXXXXAX”, where “XXXXX” is the document number and “A” is the revision level of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This document discusses the technical details and functionality of the Microchip USB Device Firmware Framework. It assumes that the programmer already is familiar with the following:

• How to write C programs
• How to use the MPLAB Integrated Development Environment (IDE)
• The microcontroller data sheet for which the code is being written
• Basic USB concepts, such as those covered in chapters 5, 8 and 9 in the official USB 2.0 specifications

Items discussed in this chapter include:

• Conventions Used in this Guide
• Recommended Reading
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Document Revision History
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

### DOCUMENTATION CONVENTIONS

<table>
<thead>
<tr>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arial font:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic characters</td>
<td>Referenced books</td>
<td>MPLAB® IDE User’s Guide</td>
</tr>
<tr>
<td>Emphasized text</td>
<td>...is the <em>only</em> compiler...</td>
<td></td>
</tr>
<tr>
<td>Initial caps</td>
<td>A window</td>
<td>the Output window</td>
</tr>
<tr>
<td></td>
<td>A dialog</td>
<td>the Settings dialog</td>
</tr>
<tr>
<td></td>
<td>A menu selection</td>
<td>select Enable Programmer</td>
</tr>
<tr>
<td>Quotes</td>
<td>A field name in a window or dialog</td>
<td>“Save project before build”</td>
</tr>
<tr>
<td>Underlined, italic text with right angle bracket</td>
<td>A menu path</td>
<td>File&gt;Save</td>
</tr>
<tr>
<td>Bold characters</td>
<td>A dialog button</td>
<td>Click OK</td>
</tr>
<tr>
<td></td>
<td>A tab</td>
<td>Click the Power tab</td>
</tr>
<tr>
<td>Text in angle brackets &lt; &gt;</td>
<td>A key on the keyboard</td>
<td>Press &lt;Enter&gt;, &lt;F1&gt;</td>
</tr>
<tr>
<td><strong>Courier New font:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plain Courier New</td>
<td>Sample source code</td>
<td>#define START</td>
</tr>
<tr>
<td></td>
<td>Filenames</td>
<td>autoexec.bat</td>
</tr>
<tr>
<td></td>
<td>File paths</td>
<td>c:\mcc18\h</td>
</tr>
<tr>
<td></td>
<td>Keywords</td>
<td>_asm, _endasm, static</td>
</tr>
<tr>
<td></td>
<td>Command-line options</td>
<td>-Opa+, -Opa-</td>
</tr>
<tr>
<td></td>
<td>Bit values</td>
<td>0, 1</td>
</tr>
<tr>
<td></td>
<td>Constants</td>
<td>0xFF, ‘A’</td>
</tr>
<tr>
<td>Italic Courier New</td>
<td>A variable argument</td>
<td>file.o, where file can be any valid filename</td>
</tr>
<tr>
<td>Square brackets []</td>
<td>Optional arguments</td>
<td>mcc18 [options] file [options]</td>
</tr>
<tr>
<td>Curly brackets and pipe character: {}</td>
<td>Choice of mutually exclusive arguments; an OR selection</td>
<td>errorlevel {0</td>
</tr>
<tr>
<td>Ellipses...</td>
<td>Replaces repeated text</td>
<td>var_name [, var_name...]</td>
</tr>
<tr>
<td></td>
<td>Represents code supplied by user</td>
<td>void main (void) { ... }</td>
</tr>
</tbody>
</table>
RECOMMENDED READING

This user’s guide describes how to use the Microchip USB Device Firmware Framework. Other documents which may be useful on this subject are listed below. The following documents are available and recommended as supplemental reference resources.

Microchip USB Device Firmware Framework Release Notes
As new versions of the USB Device Firmware Framework are developed, they will be distributed along with release notes that may cover specific and key items not necessarily covered in this User’s Guide. When new versions are released, they will be posted at the Microchip USB design center:

http://www.microchip.com/usbl/ (click on the “Full-Speed USB Solutions” link)

PIC24FJ256GB110 PIM Manual (DS39908)
USB PICtail™ Plus Daughter Board Manual (DS39909)
PICDEM™ FS USB Demonstration Board User’s Guide (DS51526)
PIC18F87J50 FS USB Plug-In Module User’s Guide (DS51678)

These documents provide information on the hardware configuration of Microchip’s USB development and demonstration kits.

Official USB 2.0 Specifications
Chapter 9 in the official USB 2.0 specifications covers the commands that all USB peripheral devices must support. This chapter is especially important as it strongly influences the requirements of USB firmware. Chapters 5 and 8 also provide useful information regarding how data moves across the USB.

The official USB specifications can be downloaded from the USB Implementers Forum web site:

http://www.usb.org/

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web site is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the web site contains the following information:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives
DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, access the Microchip web site at www.microchip.com, click on Customer Change Notification and follow the registration instructions.

The Development Systems product group categories are:

- **Compilers** – The latest information on Microchip C compilers and other language tools. These include the MPLAB C18 and MPLAB C30 C compilers; MPASM™ and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers; and MPLIB™ and MPLAB LIB30 object librarians.
- **Emulators** – The latest information on Microchip in-circuit emulators. This includes the MPLAB ICE 2000 and MPLAB ICE 4000.
- **In-Circuit Debuggers** – The latest information on the Microchip in-circuit debugger, MPLAB ICD 2.
- **MPLAB® IDE** – The latest information on Microchip MPLAB IDE, the Windows® Integrated Development Environment for development systems tools. This list is focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager and general editing and debugging features.
- **Programmers** – The latest information on Microchip programmers. These include the MPLAB PM3 and PRO MATE® II device programmers and the PICSTART® Plus and PICkit™ 1 development programmers.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

- Distributor or Representative
- Local Sales Office
- Field Application Engineer (FAE)
- Technical Support

Customers should contact their distributor, representative or field application engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY

**Revision B (March 2008)**

- Complete revision to support the Microchip USB Device Firmware framework.

**Revision A (September 2007)**

- Initial version of the document, released under the title “MCHPFSUSB Firmware User’s Guide”; written to support the predecessor the Firmware Framework.
Chapter 1. Using the USB Device Firmware Framework

1.1 HIGHLIGHTS

The items discussed in this chapter are:
- Overview of the Framework
- USB Device Firmware in the Framework

1.2 OVERVIEW OF THE FRAMEWORK

The Microchip USB Device Firmware Framework is a library that can be used to create new USB applications. It can be thought of as a reference design project, containing the necessary firmware code for USB operation and providing a placeholder for the user’s code. The whole code project is contained within one single root project directory, with many subdirectories for source code organization.

The USB Framework is based on the latest versions (as this is written) of Microchip’s development tools. To provide the best level of USB application support, you should verify that you have at least these revisions of the following tools before starting:
- MPLAB® IDE, v 8.02
- Microchip C30 C Compiler, v 3.02 or later; or Microchip C18 C Compiler, v3.10 or later

This section describes the importance in setting up the project paths and how the Framework is organized.

1.2.1 The Directory Structure

The Framework is designed in such a way that files located in the Microchip directory do not need modification. All files that need to be modified by the user are located in the <Application> folder. The directory structure of the USB Device Firmware Framework is the following:

![FIRMWARE FRAMEWORK DIRECTORY STRUCTURE](image-url)
1.2.2 The Logical Structure

The USB Firmware Framework provides a set of modular firmware interfaces that handle most of the work for implementing USB communications. Figure 1-2 shows a typical USB program flow. Each firmware reference project is written to have a cooperative multitasking environment; thus, no blocking functions should be implemented.

The main() function is an infinite loop that services different tasks. These can be logically thought of as either a USB task or a user task. USB tasks are handled by USBTasks(), which polls and services all USB hardware interrupts.

**FIGURE 1-2:** LOGICAL STRUCTURE OF THE FIRMWARE FRAMEWORK

1.2.3 Configuring MPLAB IDE for the Framework

1. Launch MPLAB IDE.
2. From the MPLAB IDE menu bar, select File > Open Workspace...
3. Navigate and select the workspace file. Please see the release notes associated with the stack for more information about the reference designs available.
4. Return to the menu bar and select Project > Build Options... > Project. The Build Options dialog appears (Figure 1-3).
5. Click on the Directories tab and verify the following:
   - The Output Directory and Intermediary Directory paths point to the directory where the output files should be placed.
   - The Include Search Path directory includes the following entries: ".", ".\Include", ".\Microchip\Include", and ".\.\.\<Application>" (see Figure 1-3 for an example). This allows the files within the Framework to locate the application-specific configuration files as well as the application-specific code to reach the Framework functions.
   - The Library Search Path points to the “lib” directory under the appropriate compilers installation directory.
   - The Linker-Script Path points to the directory of the project’s linker script file.
1.2.4 Selecting the Hardware Configuration

The Framework is set up to automatically select the correct compile-time options for the standard demo boards available from Microchip. In order to get the code to compile and link correctly, there are still a few steps that may be required by the user.

To use these projects with other microcontrollers or circuit board platforms, the following changes will be needed:

1. Open the MPLAB IDE project.
2. From the menu bar, select the microcontroller which will be used (Configure > Select Device).
3. Replace the linker script in the project with the appropriate device-specific linker script. These can be found in the \lkr directory inside the installation directory for the C18 compiler or the \support\glld directory inside the installation directory for the C30 compiler.

Note: In some cases, the C18 compiler may fail to compile correctly, giving an error that certain header files from the mcc18 library could not be found. In this case, add the path <C18 Installation directory>\h after the project root path in the Include Path field. This is often C:\mcc18.
Although the USB-specific registers are similar between all of the different Microchip USB products, a few differences still exist. For example, when configured for a PLL-Based Oscillator mode, the PIC18F4550 will power-up by default with the PLL enabled. On the PIC18F87J50 family of devices, the PLL is initially disabled even when configured for a PLL-Based Oscillator mode. If the USB module clock is being derived from the PLL, user firmware must set the PLLEN bit (OSCTUNE<6>) bit at least two milliseconds before enabling the USB module.

To accommodate these types of differences, the source code for the Framework uses #if defined statements based on the processor to change the code accordingly. The selection of the demo board is found in the HardwareProfile.h file of the example code.

If developing for a non-Microchip demo board platform, additional changes may also be needed. The example framework projects make use of the hardware features available on the demo boards, such as LEDs, push buttons, temperature sensor, RS-232 connector, etc. When developing for a different platform, these aspects of the projects will either need to be replaced or removed. The HardwareProfile.h file maps functions to pin names and will likely need modification. See Section 1.3.1.3 “HardwareProfile.h” for more details.

1.3 USB DEVICE FIRMWARE IN THE FRAMEWORK

As seen in the directory structure section above, there are three main folders associated with the USB Device Framework:

- The application folder, “<Application>”
- The USB Framework source folder, Microchip\USB
- The Framework header folder, Microchip\Include\USB

Both the application folder and the Framework folders will be discussed in detail.

1.3.1 Application Folder

The application folder contains the application-specific information. This includes the configuration information specific to this project, the application code itself, the USB descriptors and the MPLAB IDE associated files.

1.3.1.1 usb_config.h

This header file is a key element to the configuration of the USB stack. It defines various parameters inside the stack that determine how the stack will operate and which optional features to include. Changing these options can have implications of code size, RAM usage and data throughput. USB_SUPPORT_DEVICE is the definition that enabled the entire device/peripheral stack. Without this definition, the stack will not run in Device mode.

- EP0_BUFF_SIZE defines the buffer size for Endpoint 0. It can have a valid value of 8, 16, 32 or 64 bytes. This definition is used globally in the project for many things. It is used during project build to allocate appropriate buffer size for Endpoint 0. It is used in the USB descriptor to notify the USB host of the size of the Endpoint 0 buffer. It is also used during control transfer operation. When defining this variable, note that a low-speed USB device can only use an 8-byte buffer, while a full-speed USB device can use an 8, 16, 32 or 64-byte buffer.

- MAX_NUM_INT defines the size of the array which keeps track of the active alternate setting for each interface, which can be switched during operation. Valid values are integers \([0, 1, 2, ...]\). If a device has multiple configurations, the number of interfaces from the configuration with the highest number of interfaces should be used. For example, a device with two configurations has three interfaces in the first configuration and two interfaces in the second. In this case, MAX_NUM_INT should be three.
• **USB_PING_PONG_MODE** defines the Ping-Pong Buffer mode to be used during run time. The function of each mode is explained in the USB chapter of the device data sheet. The options for this setting are:

```c
USB_PING_PONG__NO_PING_PONG
USB_PING_PONG__EP0_OUT_ONLY
USB_PING_PONG__FULL_PING_PONG
USB_PING_PONG__ALL_BUT_EP0
```

Not all of these settings may be available for every device. Please check with the appropriate device data sheet.

• **USB_USE_CLASS** is used to indicate which USB classes should be included in the code project. The options for this setting are the USB classes with class-specific header files implemented in the Framework, including (among others):

```c
USB_USE_CDC
USB_USE_GEN
USB_USE_HID
USB_USE_MSD
```

When one or more of these are defined, it tells the USB global header file, `usb.h`, which class-specific header files to include. The `usb.h` header is used globally as the necessary include file when using the USB library. If the HID class is used, then `hid.c` and `hid.h` should also be added to the MPLAB IDE project. If the CDC class is used, then `cdc.c` and `cdc.h` should also be added to the MPLAB IDE project.

• **USE_USB_BUS_SENSE_IO** indicates that the firmware will use the pin defined in `HardwareProfile.h` to determine when to enable the USB module. If the target board design does not use an I/O pin to detect the presence of the USB bus, this definition must be commented out.

When `USE_USB_BUS_SENSE_IO` is undefined, the USB module will always be enabled. Using this feature helps to improve the power efficiency of the system because the USB module is only enabled when the bus is present. Additionally, in order for the device to pass USB compliance certification, all self-powered devices are required to support a bus sense feature. Self-powered devices which do not implement this feature will fail the back drive voltage tests. The USB specifications require that devices should not source current on D+ or D- (and never Vbus) unless the host is actively powering the Vbus line. A self-powered device will not know when the host is actively powering Vbus (and when it is acceptable to enable the D+ or D- pull-up resistor) unless a bus sense feature is implemented. Purely bus-powered devices do not need to implement this feature and this feature may be commented out.

• **USE_SELF_POWER_SENSE_IO** indicates that the microcontroller is sensing the presence of on-board power through an I/O pin. If the target board design does not use an I/O pin to detect the presence of self-power, this definition must be commented out.

• **USB_MAX_EP_NUMBER** must equal the highest endpoint number used in the project. For example, if the highest endpoint number used is Endpoint 5, then `USB_MAX_EP_NUMBER` should equal five. This definition is used mainly in the `usbmmap.c` to allocate the buffer descriptor registers.

• **USB_DEVICE_DESCRIPTOR** is the name of the ROM variable that contains the device descriptor information.

• **USB_CONFIG_DESCRIPTOR** is the name of the ROM variable that contains the configuration descriptor information.

In addition to the options listed above, there may be additional definitions required in `usb_config.h` in order to run certain USB class code with the Framework. Please refer to the documentation for each class in order to determine the definitions that are required.
1.3.1.2 USBDescriptors.c

This file contains the USB descriptor information for the device. This information varies based on the application.

A typical configuration descriptor consists of these components:

• At least one configuration descriptor
• One or more interface descriptors
• One or more endpoint descriptors

In addition, there is usually a descriptor string that provides a plain text description of the device.

1.3.1.2.1 Configuration Descriptor

The `bmAttributes` object of the configuration descriptor can be modified to meet the needs of the specific application. The available options are shown in Table 1-1. The selected options should be ORed together to form the corresponding entry (e.g., a device with all of the options should have "_DEFAULT | _SELF | _RWU").

For more details about the configuration descriptor, please see Table 9-10 of the USB specification.

**TABLE 1-1: bmAttributes OPTIONS FOR CONFIGURATION DESCRIPTOR**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_DEFAULT</td>
<td>Required definition that sets the reserved bits of this attribute as required by the specification.</td>
</tr>
<tr>
<td>_SELF</td>
<td>Designate this device as a self-powered device.</td>
</tr>
<tr>
<td>_RWU</td>
<td>Designate this device as having remote wake-up functionality.</td>
</tr>
</tbody>
</table>

1.3.1.2.2 Endpoint Descriptor

Both the `bEndpointAddress` and `bmAttributes` field of the endpoint descriptors have definitions available in the stack to select the various options. The options should be ORed together to form the desired set of options. The available options are shown in Table 1-2 and Table 1-3.

More information about the endpoint descriptors can be found in Table 9-13 of the USB specification.

**TABLE 1-2: bEndpointAddress OPTIONS**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_EP_IN</td>
<td>Defines the endpoint as an IN endpoint. This definition must be ORed with the endpoint number to form the required value (e.g., MY_ENDPOINT_NUMBER</td>
</tr>
<tr>
<td>_EP_OUT</td>
<td>Defines the endpoint as an OUT endpoint. This definition must be ORed with the endpoint number to form the required value (e.g., MY_ENDPOINT_NUMBER</td>
</tr>
<tr>
<td>_EPxx_OUT</td>
<td>Defines the endpoint as an OUT endpoint where &lt;xx&gt; is the endpoint number. No other definitions are required.</td>
</tr>
<tr>
<td>_EPxx_IN</td>
<td>Defines the endpoint as an IN endpoint where &lt;xx&gt; is the endpoint number. No other definitions are required.</td>
</tr>
</tbody>
</table>
TABLE 1-3: bmAttributes OPTIONS FOR ENDPOINT DESCRIPTOR

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_CTRL</td>
<td>This endpoint is used for control transfers.</td>
</tr>
<tr>
<td>_ISO</td>
<td>This endpoint is used for isochronous transfers.</td>
</tr>
<tr>
<td>_BULK</td>
<td>This endpoint is used for bulk transfers.</td>
</tr>
<tr>
<td>_INT</td>
<td>This endpoint is used for interrupt transfers.</td>
</tr>
<tr>
<td>_NS</td>
<td>If _ISO is defined, the endpoint is not synchronized.</td>
</tr>
<tr>
<td>_AS</td>
<td>If _ISO is defined, the endpoint is asynchronous.</td>
</tr>
<tr>
<td>_AD</td>
<td>If _ISO is defined, the endpoint is adaptive.</td>
</tr>
<tr>
<td>_SY</td>
<td>If _ISO is defined, the endpoint is synchronous.</td>
</tr>
<tr>
<td>_DE</td>
<td>If _ISO is defined, the endpoint is a data endpoint.</td>
</tr>
<tr>
<td>_FE</td>
<td>If _ISO is defined, the endpoint is a feedback endpoint.</td>
</tr>
<tr>
<td>_IE</td>
<td>If _ISO is defined, the endpoint is an implicit feedback data endpoint.</td>
</tr>
</tbody>
</table>

If _ISO is defined, one synchronous/adaptive option (_NS, _AS, _AD or _SY) and one data/feedback option (_DE, _FE or _IE) must also be defined. The default options are _NS and _DE (_ISO | _NS | _DE).

1.3.1.2.3 String Descriptors

Rather than appearing as a simple string of text, the descriptor is formatted in a particular data structure. The string descriptor array takes the format:

```c
ROM struct
{
    BYTE bLength;
    BYTE bDscType;
    WORD string[size];
}sdxxx=
{
    sizeof(sdxxx),
    USB_DESCRIPTOR_STRING,
    {<text>}
};
```

This structure provides a means for the C compiler to calculate the length of string descriptor, sdxxx, where “xxx” is the string index number. The first two bytes of the descriptor are the descriptor length and type. The remaining <text> are string texts which must be in Unicode format. This is achieved by declaring each character as a word type. The whole text string is declared as a word array with the number of characters equal to <size>, which must be calculated manually by counting characters and then entered into the array declaration.

For example, if the string is .USB., then the string descriptor should be (using index 02):

```c
ROM struct
{
    BYTE bLength;
    BYTE bDscType;
    WORD string[3];
}sd002=
{
    sizeof(sd002),
    USB_DESCRIPTOR_STRING,
    {'U','S','B'}
};
```
A USB project may have multiple strings. The firmware supports the management of multiple strings through a look-up table, which is defined as:

```c
ROM BYTE *ROM USB_SD_Ptr[]={&sd000,&sd001,&sd002};
```

The above example has 3 strings (sd000, sd001 and sd002). Strings can be removed or added as needed. The strings are managed by the look-up table, USB_SD_Ptr; the index of the string must match the index position of the array (sd000 must be in position, USB_SD_Ptr[0], and so on). The look-up table, USB_SD_Ptr, is used by the USBStdGetDscHandler function in usb9.c. The string descriptor, sd000, is a specialized descriptor that defines the language code, which is usually US English (0x0409).

### 1.3.1.2.4 Adding Configurations

A USB device may have more than one configuration descriptor (e.g., configDescriptor2, configDescriptor3, etc.). To add another configuration descriptor, implement a new set of structures, similar to configDescriptor1, to the USBDescriptors.c file. Once this is done, add the new configuration descriptor name (configDescriptor2, configDescriptor3) to the look-up table, USB_CD_Ptr, in the same method used for managing descriptor strings. USB_CD_Ptr[0] is a dummy place holder for configuration 0, the unconfigured state defined by the USB specification. The configuration handler, USBStdSetCfgHandler, must also be modified to support the additional configurations.

### 1.3.1.3 HardwareProfile.h

This file is used to map the various demo board hardware setups to a common definition for the code to use. This defines which port pins LEDs are located on, the clock speed of the demo board, etc. This file will also determine which demo board is currently being used by looking at the compiler that is compiling the project and the device selected in MPLAB IDE. If a custom board is required, or if a modification is made to one of the demo boards, then the DEMO_BOARD definition needs to be defined at the top of HardwareProfile.h to indicate to the compiler that it is a custom board. Custom boards may also require the addition of code for other features used by the framework.

### 1.3.2 Framework Folders

The Application Programming Interface (API) to the Framework is available in the documentation folder of the Framework distribution. This document provides a description and examples of the functions required in order to use the Framework.
# Index

<table>
<thead>
<tr>
<th>Column</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Adding Configurations</td>
</tr>
<tr>
<td></td>
<td>Application Folder</td>
</tr>
<tr>
<td>B</td>
<td>bEndpointAddress Options</td>
</tr>
<tr>
<td></td>
<td>bmAttributes Options</td>
</tr>
<tr>
<td></td>
<td>Configuration Descriptor</td>
</tr>
<tr>
<td></td>
<td>Endpoint Descriptor</td>
</tr>
<tr>
<td>C</td>
<td>Configuration Descriptor</td>
</tr>
<tr>
<td></td>
<td>Customer Notification Service</td>
</tr>
<tr>
<td></td>
<td>Customer Support</td>
</tr>
<tr>
<td>D</td>
<td>Documentation</td>
</tr>
<tr>
<td></td>
<td>Conventions</td>
</tr>
<tr>
<td>E</td>
<td>Endpoint Descriptor</td>
</tr>
<tr>
<td>F</td>
<td>Firmware Framework</td>
</tr>
<tr>
<td></td>
<td>Directory Structure</td>
</tr>
<tr>
<td></td>
<td>Configuring MPLAB</td>
</tr>
<tr>
<td></td>
<td>Selecting Hardware Configuration</td>
</tr>
<tr>
<td></td>
<td>Firmware Framework</td>
</tr>
<tr>
<td></td>
<td>Logical Structure</td>
</tr>
<tr>
<td></td>
<td>Framework Device Firmware</td>
</tr>
<tr>
<td></td>
<td>Framework Folders</td>
</tr>
<tr>
<td>H</td>
<td>HardwareProfile.h</td>
</tr>
<tr>
<td>I</td>
<td>Internet Address</td>
</tr>
<tr>
<td>M</td>
<td>Microchip Internet Web Site</td>
</tr>
<tr>
<td>R</td>
<td>Reading, Recommended</td>
</tr>
<tr>
<td>U</td>
<td>usb_config</td>
</tr>
<tr>
<td></td>
<td>USBDescriptors.c</td>
</tr>
<tr>
<td></td>
<td>Adding Configurations</td>
</tr>
<tr>
<td></td>
<td>String Descriptor Format</td>
</tr>
<tr>
<td>W</td>
<td>WWW Address</td>
</tr>
</tbody>
</table>